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Figure 1:  Flow meter installed in 
the field. 

Overview
The PT878 TransPort Ultrasonic Flow Meter:
•	 Measures liquid flow in a pipe.   
•	 Is a non-intrusive, clamp-on ultrasonic liquid flow meter for chilled 

and hot water applications
•	 Monitors flow of fluids that are homogenous, relatively clean, flowing 

steadily, and have no gas-phase substance present
•	 Has data logging capabilities and a digital display for instantaneous 

flow measurements

Applications 
The PT878 Flow Meter is often used for:
•	 Water demand analysis, including leaks.  The portable flow meter can 

serve as a sub-meter to measure cumulative amount of water used by 
a device or a sub-system of a larger metered system. 

•	 Diagnosing system performance issues like variation in flow and flow 
direction 

•	 Assessing load variation in hydronic heating or cooling systems. 
Load is calculated using the flow rate and the associated supply and 
return fluid temperatures. This application is beyond the scope of this 
Application Note.  

How it Works
This ultrasonic flow meter uses a pair of transducers, with each transducer 
sending and receiving coded ultrasonic signals through the fluid. When the 
fluid is flowing, signal transit time in the downstream direction (Figure 2a) is 
shorter than in the upstream direction (Figure 2b). The difference between 
these transit times is proportional to the flow velocity. The flow meter 
measures this time difference and uses programmed pipe parameters to 
determine flow rate and direction.
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This Application Note
This Application Note consists of two parts.  Part I describes how to 
configure the meter for flow measurements and data logging using the 
keypad interface.  Part II describes how to install two different types of 
ultrasonic flow transducers: those designed for pipes of between two and 
twenty-four inches in diameter and those designed for pipes of less than two 
inches in diameter. 
          
 
Components of the Ultrasonic Flow Meter Kit
1. TransPort portable flow meter
2. Measurement rails, including one indexed rail and one un-indexed rail. 
3. Clamping fixtures and chains
4. Transducer cables
5. Ultrasonic transducers
6. Small pipe ultrasonic transducers (may be included instead of standard 

transducers) 
7. AC power adapter (not shown)
8. Ultrasonic couplant (not shown)
9. Pipe diameter tape (not shown)
10. Thickness gauge (not shown)

Powering Up and Shutting Down the Meter
1. Press the red button to power up the meter. 
2. To shut down the meter, press the red power button until the shutdown 

options screen appears.  Choose Shutdown to shut to meter off, Sleep to 
put the meter in idle mode, or Cancel to resume operation.  

           
 

Figure 2:  Theory of transit-time flow measurement  
A)  Top view of pipe. The ultrasonic signal takes time t1 to travel downstream between 
transducers.
B)  The ultrasonic signal takes time t2 to travel upstream between transducers.
*The flow meter uses the difference between the transit times (t2 - t1 = Δt), along with the 
parameters input by the user, to calculate fluid speed and volume flow.  If the transit time 
is negative, the flow is moving opposite the expected direction.
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Figure 3:  The flow meter kit.
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Using Battery Power 
A new fully charged battery can provide a maximum of 8 to 10 hours of 
continuous operation. Batteries must be charged 8 hours to receive the 
maximum charge. The batteries recharge when the unit is plugged in to AC 
power. When data logging, it is recommended that the PT878 be run on the 
AC power.  
When the meter is running on battery power, the battery icon in the upper 
right-hand corner of the screen will show a battery level.  When the meter 
is running on AC power, the battery icon will either indicate that the battery 
is charging or will contain a lightning-bolt symbol when the battery is fully 
charged. 
           
 
Defining a Site
Before entering new meter configuration parameters the user must create 
a new site. Previously saved parameters can be reused by selecting an 
existing site and using it directly or using it as a template for a new site.   

Creating a New Site 
1. Press the Menu button until the menu list appears at the top of the 

screen.
2. Use the arrow keys to select the Site menu and press Enter.  Site 

Manager will be highlighted by default (Figure 4).

3. Press Enter to open the Site Manager menu.
4. Press the Menu button to highlight the File menu (Figure 5) and press 

Enter. New will be highlighted by default. 
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Figure 4:   Screen after pressing the Menu button 
and selecting the Site menu. 



5. Press Enter to open the New Site screen.
6. Press F1 (Delete) to delete the default site name and use the arrow keys 

to navigate the alphanumeric table to enter a descriptive site name of 
up to 8 characters. Press Enter to select each character.  Press F3 (OK) 
when the complete site name has been entered.

7. Choose whether or not to use the selected site as a template. (All 
parameters are editable so this selection is not critical, but may save 
time if there is an existing site with similar characteristics already 
programmed into the meter.)

8. Press F3 (Exit) to exit the Site Manager.

Selecting an Existing Site
1. Press the Menu button until the menu list appears at the top of the 

screen. 
2. Use the arrow keys to select the Site menu and press Enter.  Site 

Manager will be highlighted by default (Figure 4).
3. Press Enter to open the Site Manager menu (Figure 6).
4. Use the up/down arrow keys to highlight the site the user wishes to 

select. 

Figure 5:  Site Manager screen with the File menu open

Figure 6:   Site Manager screen with list of existing 
sites displayed
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      Tab 
Transducer

Pipe

Fluid

Transducer

Fluid

Fluid

Path

Fluid 
Fluid 

Field
Type

Material

Temp

Transducer

Tracking 
Windows?

Glycol

Traverses

Sound 
Speed

Fluid 

Parameter
Transducer type

Pipe material

Fluid temperature

Transducer model 
#

Activate Tracking 
Windows

Percent glycol

# of signal 
traverses

Sound Speed
Fluid type

Notes
Always clamp-on.

Editable unless Water/Glycol 
is the selected fluid. 

Most commonly used 
transducers:
#24 - 1/2” to 2” pipe.
#402 - 2” to 24” pipe.
#407 - 1/2” to 6” pipe.

Usually OFF.  Used for 
troubleshooting.

Editable only if Water/Glycol is 
the selected fluid.
Number of times the 
ultrasonic signal crosses the 
pipe. 

Editable only if Other is the 
selected fluid.

Table 1:  PT878 configuration parameters that do not require field measurements

5. Press the Menu button to highlight the File menu and press Enter 
(Figure 5).

6. Use the up/down arrow keys to highlight Open and press Enter.
7. Press F3 (Yes) or Enter to select the desired site.  
8. Press F3 (Exit) to exit the Site Manager.

 
           
Configuring Flow Parameters 
The five main configuration tabs are Transducer, Pipe, Lining, Fluid and 
Path.  The information entered is used by the meter to calculate the fluid 
flow rate.  
Many configuration parameters can be, and if possible should be, set up 
before going into the field.  Table 1 lists parameters that can be configured 
without field measurements.  Table 2 lists parameters that must be 
measured in the field. Each parameter is identified by its corresponding tab, 
field name, and parameter description.  Calculated fields are not included 
on either table.
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      Tab Field Parameter Notes
Transducer

Pipe

Pipe

Wedge Tmp

OD, in

Wall, in

Approximate 
transducer 
temperature

Pipe outside 
diameter
Pipe wall 
thickness

Use pipe surface temperature.  
Measure with surface 
temperature probe or IR 
thermometer.
Measure with pipe diameter 
tape.
Measure with PT878 thickness 
gauge.

Transducer Tab
1. Press F1 (Transducer) to display the Transducer configuration tab 

(Figure 7).
 

2. Use the down arrow key to select the transducer Type. If Clamp-on is 
not selected, use horizontal arrow key to highlight Clamp-on. Press 
Enter to accept the entry. 

3. Use the down arrow to highlight the Transducer field. Press Enter to 
view the list of transducers. See Table 1 for a list of transducer types. 

4. Use up/down arrow keys to highlight correct transducer #. Press Enter 
accept the entry. Transducers are chosen based on pipe diameter and 
fluid temperature. 

5. The next field is labeled Wedge Tmp. The wedge temperature is the 
approximate temperature of the ultrasonic transducer (“wedge”) 
which can be assumed to equal the pipe surface temperature. This 
temperature can be measured with a surface temperature meter or an 
IR thermometer.  If using an IR thermometer, to avoid low readings due 
to low emissivity of shiny metallic pipe, apply opaque tape to the location 
on the pipe where the temperature will be read. 

6. Use the down arrow to highlight the Wedge Tmp field.  Press Enter to 
clear field and use the numeric keys to enter the wedge temperature. 
Press Enter to accept the value. 

7. Press F3 (OK) to accept the changes to the Transducer tab configuration 
parameters and return to the main display screen.  Page 6 of 15

Table 2: PT878 configuration parameters that require field measurements

Table 7: Transducer configuration tab



Pipe Tab
8. Press F1 (Transducer) to display the meter configuration tabs.  Use the 

right arrow key to select Pipe. Press Enter to open the tab (Figure 8).
 

9. Press the down arrow key to highlight pipe Material field and press 
Enter to open the Material menu. Highlight the correct pipe material 
from the list with the up/down arrow keys. Press Enter to select the pipe 
material.

Pipe Thickness Measurement 
10. The GE Panametrics flow meter includes a gauge to measure pipe 

thickness (Figure 9).
11. Use the down arrow to highlight Measure Wall with TGauge box and 

press Enter.  The Thickness Gauge Measure screen with appear (Figure 
10). 

 

Figure 9:  
(A) Pipe thickness gage
(B) Calibration case
(C) Couplant gel
(D) Pipe diameter tape

Figure 8: Pipe configuration tab. 

Figure10: Wall Thickness measurement screen. 
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12. Check the calibration of the thickness gauge using the 0.2 inch and 1.5 
inch dual calibration block.

 a. Connect the thickness gauge to the keyed connector jacks on top of  
 the meter.

 b. On the Thickness Gauge Measure screen, use the right arrow key to  
 select the Material tab and press Enter to open the tab. 

 c. Use the down arrow key to highlight the Material field and press   
 Enter to open the Material menu.  Use the arrow keys to    
 select Steel (Stainless 302) and press Enter to accept the selection. 

 d. Use the arrow keys to select the Display tab and press Enter to open  
 the tab. 

 e. Place a small bead of thickness gauge couplant (Couplant B) on   
 the 0.2 inch side of the dual calibration block and press    
 the calibration gauge against that side of the block.  A clock icon will  
 appear for several seconds until the  thickness     
 reading appears. Note the reading. 

 f. Repeat step e with the 1.5 inch side of the calibration block. 
 g. If the readings vary more than ±0.002 inch from 0.2 inches or ±0.02   

 inch from 1.5 inches, respectively, calibrate the thickness gauge per  
 step 13 below.  Otherwise skip calibration.  

13. If necessary, calibrate the thickness gauge using the 0.2 inch and 1.5 
inch dual calibration block. 

 a. If it has not been done already, connect the thickness gauge to the   
 meter and select Steel (Stainless 302) in Material field on the   
 Material tab, as described in step 12a, b and c above. 

 b. Use the arrow keys to the select the Zero tab and press Enter to   
 open. 

 c. Use the arrow keys to highlight Dual Calibration and press Enter to  
 select.

 d. Use the down arrow key to highlight the Block 1 Length field.  Press  
 Enter to edit the field, enter 0.2 and press Enter again.

 e. Use the right arrow key to highlight the box containing the word   
 “Calibrate” located to the right of the Block 1 Length field.  Press   
 Enter.  The box will now read “Ready”. 

 f. Place a small bead of thickness gauge couplant (Couplant B) on   
 the 0.2 inch side of the dual calibration block and press the    
 calibration gauge against that side of the block.  Press Enter.    
 A clock icon will appear for several seconds and then the box   
 will again read “Calibrate”.  

 g. Repeat steps f, g and h for the 1.5 inch side of the dual calibration   
 block using the fields associated with Block 2 Length.  The    
 Set button will appear once the user is done calibrating with the 1.5  
 side of the dual calibration block.

 h. Once the Set button appears, press Enter.  Press F3 to go back to   
 the Pipe tab.  

 i. Check that calibration has been successful.  With Measure Wall   
 with TGauge highlighted, press Enter to return to the Thickness   
 Gauge Measure screen. Evaluate the results as indicated in   
 12g above.
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14. Before measuring pipe thickness, select the correct pipe material.  From 
the Thickness Gauge Measure screen, use the right arrow key to select 
the Material tab and press Enter. Use the down arrow key to highlight 
the Material field and press Enter to open the Material menu.  Use the 
arrow keys to select the appropriate pipe material and press Enter to 
accept the selection. 

15. Prepare the pipe. The user will take thickness measurements on the 
section of pipe where the clamping fixture, rails and transducers will be 
installed.  On this section of pipe, cut back the insulation, remove any 
paint, and clean the pipe and sand off any corrosion or rough spots. If 
the pipe is extremely rough the thickness measurements may not be 
accurate and, once the transducers are installed, the ultrasonic signal 
will be scattered by the rough surface and will not be received by the 
flow meter, preventing flow measurement.

16. Apply thickness gauge couplant (Couplant B) at the spot on the pipe 
where the user will be making the thickness measurement. The 
smoother the pipe surface the thinner the couplant should be applied. 
The line on the face of the transducer should be positioned so that it is 
perpendicular to the liquid flow in the pipe (Figure 11). 

17. Hold the pipe thickness transducer flat against the pipe surface. Note 
the measured pipe wall thickness value displayed on the meter. Press 
F3 (OK) to return to the Pipe menu. Use the arrow keys to highlight the 
Wall, in field. Press Enter to clear the field and enter the pipe thickness 
with the numeric keys. Press Enter to accept the value.  

18. Measure the outside diameter of the pipe with the pipe diameter 
measuring tape included with the pipe thickness gauge kit, as shown 
in Figure 12. Use the arrow keys to toggle to the OD, in field and press 
Enter to clear the field. Enter the pipe outside diameter in inches with 
the numeric keys and press Enter to accept the value.  

19. Press F3 (OK) to accept the changes to the Pipe tab configuration 
parameters and return to the main display screen.  

Lining Tab
20. Press F1 (Transducer) to display the meter configuration tabs.  Use the 

arrow keys to select the Lining tab and press Enter.  
21. If the pipe has no anti-corrosion lining, check that the lining Material 

field is set to None, the default value.

Figure 11: Proper alignment of 
thickness transducer on cylindrical  
run of pipe.
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Figure 12: Pipe-diameter tape 
being used to measure a 3.5 in. 
diameter pipe. 



22. If the pipe has an anti-corrosion lining, use the arrow keys to highlight 
the Material field and press Enter to open the lining Material menu. 
Use the up/down arrow keys to highlight the lining material. Press Enter 
to select.

23. Press F3 (OK) to accept the default setting or the changes to the Lining 
tab.

Fluid Tab
The options available on the Fluid tab will vary depending on whether the 
meter’s Energy Options are enabled or disabled.

Selecting Energy Options 
This section will address Energy Options as they relate to configuration of 
the Fluid tab. Though it is beyond the scope of this Application Note, the 
Energy Options screen can also be used to configure temperature inputs 
required for the meter to calculate heating or cooling loads.  See the PT878 
Operation & Installation Guide for details. 
If Energy Options are disabled, the Fluid field on the Fluid tab will display 
a pre-defined list of fluids, including Water, and an Other fluid option.  If 
Energy Options are enabled, the Fluid field will display a list including 
Other, Water, and Water/Glycol, with no additional pre-defined fluids 
available.  
As a result, if the working fluid is water or a custom fluid not defined in 
the PT878’s fluid list, Energy Options may be either enabled or disabled. If 
the working fluid is a water-and-glycol mix, enabling Energy Options will 
simplify the configuration of fluid parameters because the fluid will not have 
to be entered as a custom fluid. In order to select a fluid other than water 
from the PT878’s pre-defined fluid list, Energy Options must be disabled.  

a. To configure Energy Options, first press the Menu button until the menu 
list appears at the top of the screen. 

b. Use the arrow keys to select the Program menu and press Enter.  Use 
the down arrow key to select Energy (Figure 13).   Press Enter again to 
open the Energy Options screen (Figure 14).

 

 

Figure 13: Select Energy from the Program 
menu to open the Energy Options screen.
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c. Use the arrow keys to select Enable or Disable. Press Enter and then 
F3 (OK) to accept the selection and return to the main screen.  Note that 
when Energy Options are enabled a flame icon appears in the System 
Tray near the bottom of the screen.

24. Once the appropriate Energy Options are selected, press F1 
(Transducer) to display the meter configuration tabs.  Use the arrow keys 
to highlight the Fluid tab. Press Enter to open the tab (Figure 15).

 

25. Leave the Tracking Windows option set to “No”.  Tracking windows are 
used for advanced trouble shooting and are beyond the scope of this 
Application Note. 

26. Use the arrow keys to highlight the Fluid field and press Enter to open 
flow meter’s Fluid list.  Select either a pre-defined fluid from the Fluid 
list, or, if the fluid is not on the list, select Other.  Press Enter to accept 
the selection.

Figure 14: Energy Options screen.

Figure 15:  Fluid configuration tab. 
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27. If Other was selected as the fluid type the user will need to define the 
fluid’s behavior by entering a sound speed into the Sound Speed field. 
Fluid sound speeds can be found in the Installation Reference manual 
titled Sound Speed and Pipe Size Data (included with this flow meter) or 
in an alternative reference source.  Use the arrow keys to toggle to the 
Sound Speed field.  Press Enter to clear the field and enter the speed 
of sound for the appropriate fluid with the numeric keys. Press Enter to 
accept the selection. 

28. If a pre-defined fluid or Other has been chosen from the Fluid list, use 
the arrow keys to highlight the fluid Temperature field. 

29. If a water/glycol mix has been selected as the working fluid, the Glycol 
field will be editable rather than the fluid Temperature field.  Use the 
arrow keys to highlight the Glycol percent field. 

30. Once the editable field has been selected (either Temperature or 
Glycol), press Enter to clear the field and use the numeric keys to enter 
appropriate value.  Press Enter to accept the new value.  

31. Press F3 (OK) to accept the changes to the Fluid tab configuration 
parameters and return to the main display screen.  

Path Tab 
32. Press F1 (Transducer) to display the meter configuration tabs. Use the 

arrow keys to highlight the Path tab and press Enter (Figure 16).  The 
Traverses field is the only editable field on the Path tab. The transducer 
spacing shown in the Spacing field is calculated based on all of the other 
user-input parameters and is required for correct installation of the flow 
transducers. 

 

33. The value in the Traverses field indicates the number of times the 
ultrasonic signal crosses through the fluid from one side of the pipe 
to the other in transit between the two ultrasonic flow transducers.  
See Figure17.   To input this value, use the arrow keys to highlight the 
Traverses field. Press Enter. Use the arrow keys to choose 2 traverses, 
unless the user has a reason to use a different transducer configuration. 
Press Enter to select.

Figure 16: Path configuration tab. 
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34. The value in the Spacing field is the Transducer Spacing calculated by 
the meter after all of the measurement parameters have been entered. 
Press F3 (OK). If prompted, press F3 (OK) again to acknowledge the 
Warning message that indicates that the transducer spacing has 
changed. Make note of the Transducer Spacing value. 

35. Press F3 (Save Now). Press F3 (Yes) to choose the site name that is 
displayed in the Save Site screen.   

            
 

Changing Display Values and Units
To change the display units between Metric and English units do the 
following:
1. Press the Menu button until the menu list appears at the top of the 

screen. 
2. Use the arrow keys to select the Meter menu. Press Enter.
3. Use the arrow keys to highlight Units. Press Enter.
4. Use the arrow keys to select Metric or English units. Press F3 (OK) to 

accept the selection. 

To display different measured and calculated values and change display 
units in any of the PT878 output windows, do the following:
1. Press the Menu button until the date and time are shown at the top of 

the screen. 
2. Press the down arrow key until a triangle appears on the left edge of the 

title bar in the appropriate output window. Press Enter.  
3. Use the arrow keys to highlight Measurement and press Enter. 
4. Use the up and down arrow keys to highlight the desired display 

parameter.
5. Press the SEL button to select the parameter and use the up and down 

arrow keys to highlight the desired units.  Press F3 (OK) to accept the 
selection. 

           
 

Figure 17: Ultrasonic signal traverses

Top views of pipe. The number of traverses indicates the number of times the 
ultrasonic signal crosses the pipe.  a) One (1) traverse.  b)  Two (2) traverses 
c) Three (3) traverses  c) Four (4) traverses.  It is most common to use two (2) 
traverses.  Additional traverses weaken the signal but provide a more accurate 
flow measurement. 
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Configuring Flow Meter for Data Logging
1. When logging, it is recommended that the PT878 be run on AC power.  

Note that a new, fully-charged battery can provide a maximum of 8 to 10 
hours of continuous operation. 

2. Press the Menu button until the menu list appears at the top of the 
screen. 

3. Use the arrow keys to highlight Logging tab, New Log and press Enter.
4. Press F1 (Delete) to delete the default log name and use the arrow 

keys to select a log name, pressing Enter after each letter or number 
is highlighted. Press F3 (OK) when the complete log name has been 
entered.  Two logging configuration tabs will be displayed: General and 
Measurements.   

General Tab 
5. Use the arrow keys to toggle between the Format options and press 

Enter to select. Choose Linear to program the meter to stop logging 
when the memory is full. The Linear option is the more appropriate one 
for most logging applications. Choose Circular to program the meter to 
continue to log when the memory is full by overwriting the earliest data 
records with the newest data.

6. Use the arrow keys to select log Type.  Choose Standard and press 
Enter.

7. Enter the Start and End dates and times.  Toggle to the correct field to 
highlight. Press Enter and then edit the values in the field with the arrow 
keys. Press Enter after each field has been edited and use the arrow 
keys to toggle to the next field.

8. Use the arrow keys to toggle to the Logging Interval field. Press Enter 
to activate the text box and use the numeric keys to enter the logging 
interval.

Measurements  Tab 
9. Use the arrow keys to select the Measurements tab and press Enter to 

open. 
10. Use the arrow keys to highlight one of the variable boxes on the 

Measurements table. The box will initially read “NO UNITS”. Press Enter 
to open the Measurements variable list. 

11. Use the up and down arrow keys to indicate the desired variable. Press 
the SEL button to confirm the selection. The prompt automatically 
moves to the list of unit types. 

12. Use the arrow keys to highlight the desired units.  Press the SEL button 
to select the units and then press F3 (OK) to confirm the selection. 
Once selected, the measurement variable and units will appear in the 
Measurements table. 

13. Repeat for up to 12 different parameters.
14. Press F3 (Activate) to Activate the Log.
15. Press F3 (Exit) to exit the log menu and return to the main flow screen.  

Press F3 (Save Now) to save changes.
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16. Note that if a log has been created and has started logging (Running), a 
pencil with horizontal lines on its left side will appear in the System Tray 
at the bottom of the screen. If a log has been created but has not started 
logging (Pending), a pencil without horizontal lines will appear in the 
System Tray. If all logging is complete or no logs have been created (no 
logs are Pending or Running), no pencil will appear in the System Tray.

           
 
Downloading the Data Log from the meter to the PC
1. Load the PanaLogViwer software from the CD included with the flow 

meter.  This software is compatible with Windows operating systems 
only. 

2. Connect the serial IR port adaptor to the PC serial port. To install the 
adaptor, either follow the windows “New Hardware” prompts to find and 
install the default drivers or   follow the manufacturer’s instructions. 
Manufacturer’s instructions may be provided with this meter or can be at 
the manufacturer’s web site. 

3. If the user has difficulty connecting, make sure that the COM port 
selected in the IR adaptor software (e.g. COM1) matches the COM 
port available on the user’s computer. Use the IR adaptor installation 
software and the computer’s Hardware Device Manager to find COM port 
assignment information. 

4. Once the IR adaptor is working, place the IR port on the adaptor directly 
in front of the IR port on the meter.

5. On the PT878 console, press the Menu button and use the arrow keys to 
highlight the Logging menu heading. Press Enter.

6. Highlight Log Manager and press Enter. Use the arrow keys to highlight 
the correct log to download. 

7. Press the Menu button to highlight the File menu heading and press 
Enter.  Use the arrow keys to highlight Transfer and press Enter.

8. A message will be displayed on the computer screen indicating that 
a file is being sent through a wireless link. Click yes to accept the file 
transfer.  It may take several minutes for the file to transfer to the user’s 
computer.  The transfer is proceeding correctly unless an error message 
is displayed. 

9. Open the PanaLogViewer software. Choose File; Open. Select the .LOG 
file and click the OPEN button.

10. Click the EXPORT button to convert the .LOG file to a .CSV file that can 
be opened and viewed in EXCEL. (Note that exporting directly to an 
XLS spreadsheet data format is unreliable and may cause the Panalog 
application to terminate without warning.  However, this does not 
damage the data file.)

11. When finished, turn the meter power off.
12. If after transferring data the user has trouble using the COM ports on 

his or her computer, check the computer’s Hardware Device Manager to 
make sure the IR adaptor is not monopolizing the active COM port. 
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